
www.hilscher.com 

 
 
 
 
 
 
 
 
 
 
 
 

Operating Instruction Manual 
 

Generic EtherCAT Slave DTM for EtherCAT Slave Devices 
 

Configuration of EtherCAT Slave 
 
 

Language: English 
 

 

 

 

 



Generic EtherCAT Slave DTM Table of Contents  •  2 

Hilscher Gesellschaft für Systemautomation mbH – Rheinstr. 15 – D 65795 Hattersheim  
Edition 3 – Oi:DTMECS#EN – 2009/06 

Table of Contents 

1 INTRODUCTION.........................................................................................................4 
1.1 About this Manual .......................................................................................................4 

1.1.1 Online Help...........................................................................................................4 
1.1.2 List of Revisions ...................................................................................................5 
1.1.3 Conventions in this Manual ..................................................................................5 

1.2 Legal Notes.................................................................................................................6 
1.2.1 Important Notes ....................................................................................................6 
1.2.2 Exclusion of Liability .............................................................................................7 
1.2.3 Warranty ...............................................................................................................7 
1.2.4 Export Regulations ...............................................................................................8 
1.2.5 Registered Trademarks........................................................................................8 

1.3 About EtherCAT Generic Slave DTM .........................................................................9 
1.3.1 Requirements .......................................................................................................9 

1.4 Dialog Structure of the EtherCAT Generic Slave DTM.............................................10 
1.4.1 General Device Information................................................................................11 
1.4.2 Navigation Area ..................................................................................................11 
1.4.3 Dialog Pages ......................................................................................................12 
1.4.4 Controls and Dialog Buttons...............................................................................13 
1.4.5 Status Bar...........................................................................................................14 

2 GETTING STARTED.................................................................................................15 
2.1 Configuration Steps ..................................................................................................15 

2.1.1 Configuring Device Parameters .........................................................................16 

3 CONFIGURATION ....................................................................................................17 
3.1 Overview Configuration ............................................................................................17 
3.2 General .....................................................................................................................18 
3.3 Behavior....................................................................................................................19 

3.3.1 State Machine Timeout ......................................................................................20 
3.3.2 Device Check-up ................................................................................................21 
3.3.3 Process Data ......................................................................................................22 
3.3.4 Watchdog ...........................................................................................................23 

3.4 Process Data ............................................................................................................24 
3.4.1 Sync Manager ....................................................................................................25 
3.4.2 PDO Assignment (Index 0x1C10- 0x1C1F) .......................................................27 
3.4.3 PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF) ...................................29 

3.5 Mailbox .....................................................................................................................30 
3.5.1 CoE.....................................................................................................................30 

4 DESCRIPTION..........................................................................................................31 
4.1 Overview Description................................................................................................31 
4.2 XML DDF Viewer ......................................................................................................32 



Generic EtherCAT Slave DTM Table of Contents  •  3 

Hilscher Gesellschaft für Systemautomation mbH – Rheinstr. 15 – D 65795 Hattersheim  
Edition 3 – Oi:DTMECS#EN – 2009/06 

5 LISTS ........................................................................................................................33 
5.1 List of Figures ...........................................................................................................33 
5.2 List of Tables ............................................................................................................34 

6 GLOSSARY...............................................................................................................35 

7 APPENDIX ................................................................................................................37 
7.1 User Rights ...............................................................................................................37 

7.1.1 Configuration ......................................................................................................37 
7.2 References ...............................................................................................................38 
7.3 Contacts....................................................................................................................39 

 

 

 

 



Generic EtherCAT Slave DTM Introduction  •  4 

Hilscher Gesellschaft für Systemautomation mbH – Rheinstr. 15 – D 65795 Hattersheim  
Edition 3 – Oi:DTMECS#EN – 2009/06 

1 Introduction 
1.1 About this Manual 

This manual provides information on how to set up EtherCAT Slave devices 
described with XML DDF files. These devices can be configured with the 
EtherCAT Generic Slave DTM within an FDT Framework.  

Dialog Pages 
The table below gives an overview for the individual dialog pages 
descriptions: 
 

Section Subsection Manual  
Page 

Configuration Overview Configuration 17 

 General  18 

 Behavior 19 

 State Machine Timeout 20 

 Device Check-up 21 

 Process Data 22 

 Watchdog 23 

 Process Data 24 

 Sync Manager 25 

 PDO Assignment (Index 
0x1C10- 0x1C1F) 

27 

 PDO Content (Index 0x1600-
0x17FF, 0x1A00-0x1BFF) 

29 

 Mailbox 30 

 CoE 30 

Description Overview Description 31 

 XML DDF Viewer 32 

Table 1: Overview Dialog Pages 

 

1.1.1 Online Help 
The Generic EtherCAT Slave DTM contains an integrated online help 
facility. 

 To open the online help, click on the Help button or press the F1 key. 
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1.1.2 List of Revisions 
 

Index Date Version Component Chapter Revisions 

1 13.12.07 0.9.0.0 
1.0.3.0 

ECATGenericSlaveDTM.dll 
ECATGenericSlaveGUI.ocx  

all created 

2 20.01.09 0.900.121
4.6448 
1.0.3.0 

ECATGenericSlaveDTM.dll 
ECATGenericSlaveGUI.ocx  

- Revised 

3 02.06.09 0.900. 
1625.x 

ECATGenericSlaveDTM.dll 
ECATGenericSlaveGUI.ocx  

1.4.4.2 
1.4.5 
3.4 

Section „Table Line Buttons“ added 
Section „Status Bar“ actualized, 
Some changes and additions. New 
screenshots. 

 

 

1.1.3 Conventions in this Manual 
Operation instructions, a result of an operation step or notes are marked as 
follows: 

Operation Instructions: 
 

 <instruction> 
 

Or 
 

1. <instruction> 

2. <instruction> 
 

Results: 
 

<result> 
 

Notes: 
 

 

Important: <important note> 

 

 
Note:  <note> 

 

 

 <note, were to find further information> 
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1.2 Legal Notes 
© 2008-2009 Hilscher Gesellschaft für Systemautomation mbH   

All rights reserved. 

The images, photographs and texts in the accompanying material (user 
manual, accompanying texts, documentation, etc.) are protected by 
German and international copyright law as well as international trade and 
protection provisions. You are not authorized to duplicate these in whole or 
in part using technical or mechanical methods (printing, photocopying or 
other methods), to manipulate or transfer using electronic systems without 
prior written consent. You are not permitted to make changes to copyright 
notices, markings, trademarks or ownership declarations. The included 
diagrams do not take the patent situation into account. The company 
names and product descriptions included in this document may be 
trademarks or brands of the respective owners and may be trademarked or 
patented. Any form of further use requires the explicit consent of the 
respective rights owner. 
 

 

1.2.1 Important Notes 
The user manual, accompanying texts and the documentation were created 
for the use of the products by qualified experts, however, errors cannot be 
ruled out. For this reason, no guarantee can be made and neither juristic 
responsibility for erroneous information nor any liability can be assumed. 
Descriptions, accompanying texts and documentation included in the user 
manual do not present a guarantee nor any information about proper use 
as stipulated in the contract or a warranted feature. It cannot be ruled out 
that the user manual, the accompanying texts and the documentation do 
not correspond exactly to the described features, standards or other data of 
the delivered product. No warranty or guarantee regarding the correctness 
or accuracy of the information is assumed.  

We reserve the right to change our products and their specification as well 
as related user manuals, accompanying texts and documentation at all 
times and without advance notice, without obligation to report the change. 
Changes will be included in future manuals and do not constitute any 
obligations. There is no entitlement to revisions of delivered documents. 
The manual delivered with the product applies.  

Hilscher Gesellschaft für Systemautomation mbH is not liable under any 
circumstances for direct, indirect, incidental or follow-on damage or loss of 
earnings resulting from the use of the information contained in this 
publication. 
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1.2.2 Exclusion of Liability 
The software was produced and tested with utmost care by Hilscher 
Gesellschaft für Systemautomation mbH and is made available as is. No 
warranty can be assumed for the performance and flawlessness of the 
software for all usage conditions and cases and for the results produced 
when utilized by the user. Liability for any damages that may result from the 
use of the hardware or software or related documents, is limited to cases of 
intent or grossly negligent violation of significant contractual obligations. 
Indemnity claims for the violation of significant contractual obligations are 
limited to damages that are foreseeable and typical for this type of contract. 

It is strictly prohibited to use the software in the following areas: 

• for military purposes or in weapon systems;  

• for the design, construction, maintenance or operation of nuclear 
facilities; 

• in air traffic control systems, air traffic or air traffic communication 
systems;  

• in life support systems;  

• in systems in which failures in the software could lead to personal injury 
or injuries leading to death. 

We inform you that the software was not developed for use in dangerous 
environments requiring fail-proof control mechanisms. Use of the software 
in such an environment occurs at your own risk. No liability is assumed for 
damages or losses due to unauthorized use. 

 

 

1.2.3 Warranty 
Although the hardware and software was developed with utmost care and 
tested intensively, Hilscher Gesellschaft für Systemautomation mbH does 
not guarantee its suitability for any purpose not confirmed in writing. It 
cannot be guaranteed that the hardware and software will meet your 
requirements, that the use of the software operates without interruption and 
that the software is free of errors. No guarantee is made regarding 
infringements, violations of patents, rights of ownership or the freedom from 
interference by third parties. No additional guarantees or assurances are 
made regarding marketability, freedom of defect of title, integration or 
usability for certain purposes unless they are required in accordance with 
the law and cannot be limited. Warranty claims are limited to the right to 
claim rectification. 
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1.2.4 Export Regulations 
The delivered product (including the technical data) is subject to export or 
import laws as well as the associated regulations of different counters, in 
particular those of Germany and the USA. The software may not be 
exported to countries where this is prohibited by the United States Export 
Administration Act and its additional provisions. You are obligated to 
comply with the regulations at your personal responsibility. We wish to 
inform you that you may require permission from state authorities to export, 
re-export or import the product. 

 

 

1.2.5 Registered Trademarks 
Windows® 2000/Windows® XP are registered trademarks of Microsoft 
Corporation. 

Adobe-Acrobat® is a registered trademark of the Adobe Systems 
Incorporated. 

EtherCAT® is a registered trademark of Beckhoff Automation GmbH, Verl, 
Germany, formerly Elektro Beckhoff GmbH. 

All other mentioned trademarks are property of their respective legal 
owners. 
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1.3 About EtherCAT Generic Slave DTM 
You can use the EtherCAT Generic Slave DTM to configure the EtherCAT 
slaves described with XML DDF files within a FDT Framework.  

The informations necessary for the configuration of the EtherCAT Slave 
devices are stored within the EtherCAT Master device when using the 
EtherCAT Generic Slave DTM and thus the Master is configured. 

 

1.3.1 Requirements 
System Requirements 

• Windows® 2000/ Windows® XP 

• CD ROM drive 

• Graphic resolution: min. 1024 x 768 pixel 

• Keyboard and Mouse 

 

Requirements EtherCAT Generic Slave DTM 

Requirements for working with an EtherCAT Generic Slave DTM. 

• Installed FDT Framework 

• Installed EtherCAT Master DTM 

• DDF file of the devices to configure 

• The user needs to reload the Device Catalog 

 

Loading XML DDF files 
To work with the EtherCAT Generic Slave DTM, the XML-DDF file of the 
device must be copied into the DDF folder in the installation directory of the 
DTM.  
 

 

For further information refer to section Configuration Steps on page 15 , 
under step 1 and 2. 
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1.4 Dialog Structure of the EtherCAT Generic Slave DTM 
The graphical user interface of the DTM is composed of different areas and 
elements listed hereafter: 

1. A header area containing the General Device Information, 

2. The Navigation Area (area on the left side), 

3. The Dialog Pane (main area on the right side), 

4. The general buttons OK, Cancel, Apply, Help, 

5. The Status Line containing information e. g. the online-state of the 
DTM. 

 

General Device Information 

 

 

Navi 
gation 
Area 

 

 

 

Dialog Pane 

 OK Cancel Apply Help 

Status Line 

Figure 1: Dialog Structure of Generic EtherCAT Slave DTM 

 

 



Generic EtherCAT Slave DTM Introduction  •  11 

Hilscher Gesellschaft für Systemautomation mbH – Rheinstr. 15 – D 65795 Hattersheim  
Edition 3 – Oi:DTMECS#EN – 2009/06 

1.4.1 General Device Information 
 

Parameter Meaning 

IO Device Name of the device 

Vendor Vendor name of the device 

Device ID Identification number of the device 

Vendor ID Identification number of the vendor 

Table 2: General Device Information 

 

1.4.2 Navigation Area 
The Navigation Area at the left side of the dialog provides a tree structure 
to navigate through the panes of the DTM. 

 
Figure 2: Navigation Area 

 

 To access a DTM pane select the respective item of the navigation tree 
structure. 

 

The Navigation Area can be hidden or it can be displayed again. 
 

Control Meaning 

 Window button to hide the navigation area,  
(at the right side of the navigation title bar). 

 
Show navigation area button to open the navigation 
area,  
(at the lower left corner of the dialog pane). 

Table 3: Hide / display Navigation 
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1.4.3 Dialog Pages 
At the dialog pane the Configuration or Description panes are opened via 
the corresponding folder in the navigation area. 
 

Configuration 

General At the General page EtherCAT Slave information is displayed. 
For further information, refer to section General on page 18. 

Behavior At page Behavior the parameters of the Device checkup, the 
Process Data and the Watchdog are described. For further 
information, refer to section Behavior on page 19. 

Process data At page Process Data the parameters of the Sync Manager are 
displayed, the PDO Assignment and the PDO content. For further 
information, refer to section Process Data on page 24. 

Mailbox At page Mailbox you can get information on mailbox-based data 
transfer and the CoE (CANopen over Ethernet) functionality. For 
further information, refer to section Mailbox on page 27. 

Description 

XML DDF Viewer By use of the XML DDF-Viewer a DDF file can be viewed and 
searched through. For further information, refer to section XML 
DDF Viewer on page 32. 

Table 4: Overview Settings and Configuration Pages 
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1.4.4 Controls and Dialog Buttons 
In this section, you will find general information on controls and buttons. 

1.4.4.1 General Buttons 

The table below explains the general buttons in the DTM user interface. 
 

Button Meaning 

OK To confirm your latest settings, click on the OK button. All changed values 
will be applied on the frame application database.  
The dialog then closes. 

Cancel To cancel your latest changes, click on the Cancel button.  
Answer to the safety query Configuration data has been changed. Do 
you want to save the data? by Yes, No or Cancel. 
Yes: The changes are saved or the changed values are applied on the 
frame application database.  
The dialog then closes. 
No: The changes are not saved or the changed values are not applied on 
the frame application database.  
The dialog then closes. 
Cancel: Back to the DTM. 

Apply To confirm your latest settings, click on the Apply button. All changed 
values will be applied on the frame application database.  
The dialog remains opened. 

Help To open the DTM online help, click on the Help button.  

Table 5: General Buttons 

 

1.4.4.2 Table Line Buttons 

 To select, create or delete a line in a table use the buttons shown in the 
table below. 

 

Button Meaning 

 
To select the first line of a table use the button First Line. 

 
To select the previous line of a table use the button Previous Line. 

 
To select the next line of a table use the button Next Line. 

 
To select the last line of a table use the button Last Line. 

 
The button Create a new Line inserts new lines into the table. 

 
The button Delete selected Line deletes the selected line from the table.  

Table 6: Table Line – Buttons 
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1.4.5 Status Bar 
 

The Status Bar displays information about the current state of the DTM. 
The current activity, e.g. download, is signaled graphically via icons in the 
status bar. 

 
Figure 3: Status Bar – Status Fields 1 to 6 

 

Status 
Field 

Icon / Meaning 

1 DTM Connection States 
 

 
Connected: Icon closed = Device is online 

 
 

Disconnected: Icon opened = Device is offline 

2 Data Source States 
 

 
Data set: The displayed data are read out from the instance data set 
(database). 

 
 

Device: The displayed data are read out from the device. 

3 States of the instance Date Set 
 

 
Valid Modified: Parameter is changed (not equal to data source). 

4 Changes directly made on the Device 
 

 
Load/configure diagnosis parameters: Diagnosis is activated. 

6 Device Diagnosis Status 
Save operation succeeded: The save operation has been successful.  

 
Further messages due to successful handling of device data. 

Save operation failed: The save operation has failed.  
 

Further fail operation messages due to incorrect communication due to 
malfunction in the field device or its peripherals. 

Table 7: Status Bar Icons [1] 

 

Offline State 
 

 

Save operation 
succeeded 

 

Online State and 
Diagnosis  

Figure 4: Status Bar Display Examples 
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2 Getting Started 
2.1 Configuration Steps 

The following table describes the steps to configure a device with the 
Generic EtherCAT Slave DTM as it is typical for many cases. At this time it 
is presupposed that the EtherCAT Master DTM installation was already 
done. 
 

# Step Short Description For detailed information see 
section 

Page 

1 Add EtherCAT Slave in 
the Device Catalog 

Add the Slave in the Device Catalog by importing 
the device description file to the Device Catalog. 
Depending of the FDT Container. 
For netDevice: 
- Network > Import Device Descriptions. 

 
(See User Manual netDevice 
and netProject) 

- 

2 Load device catalog Depending of the FDT Container: 
For netDevice: 
- select Network > Device Catalog, 
- select button Reload Catalog. 

 
(See User Manual netDevice 
and netProject) 

- 

3 Create new project / 
Open existing project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

 
(See User Manual of the 
Frame Application) 

- 

4 Insert Master or Slave 
into configuration 

Depending of the FDT Container: 
For netDevice: 
- in the Device Catalog click to the Master, 
- and insert the device via drag and drop  
to the line in the network view, 
- in the Device Catalog click to the Slave, 
- and insert the device via drag and drop  
to the Master bus line in the network view. 

- - 

5 Configure Slave Configure the Slave. 
- Double click to the device icon of the Slave. 
- The Generic Slave DTM configuration dialog is 
displayed. 
In the Generic Slave DTM configuration dialog: 
-  configure the EtherCAT device parameters. 
- close the Generic Slave DTM configuration dialog 
via the button OK. 

Configuring Device 
Parameters 
 
 
 
 

16 
 
 
 
 

6 Configuration Steps 
Master device 

Configure the Master device via EtherCAT-Master 
DTM. 

(See User Manual DTM for 
EtherCAT-Master devices) 

- 

7 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

 
(See User Manual of the 
Frame Application) 

- 

Table 8: Getting Started - Configuration Steps 

 

 

For information to further steps as Download Configuration or 
Diagnosis, refer to the user manual DTM for EtherCAT-Master devices. 
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2.1.1 Configuring Device Parameters 
The following steps are needed to configure the device parameters using 
the EtherCAT Generic Slave DTM: 

 Configure the behavior of the EtherCAT-Slave as described in section 
“Behavior” at page 19. 

 On the Behavior page set the parameters for  

• the Device checkup,  

• the Process data  

• and the Watchdog. 

 Configure the process data of the EtherCAT-Slave as described in 
section “Process Data” at page 24. 

 On the Process Data page set the parameters for  

• the Sync Manager,  

• the PDO Assignment (0x1C10-0x1C2F) 

• and the PDO Content (0x1600-0x17FF). 
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3 Configuration 
3.1 Overview Configuration 

 

Configuration Dialog Pages 
The table below gives an overview for the Configuration dialog pages 
descriptions: 
 

Section Page 

General  18 

Behavior 19 

Process Data 24 

Mailbox 27 

Table 9: Descriptions of the Dialog Pages Configuration 

 

 
Figure 5: Navigation Area - Configuration 
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3.2 General 
The General dialog page shows the Description of the EtherCAT Slave. 
 

 
Note: The Station Address is set by the EtherCAT Master, therefore the 
corresponding data field is not editable. 

 

 
Figure 6: Configuration > General 

 

Parameter Meaning 

Description Symbolic Name of the EtherCAT Slave station. 
Device type Device type as defined in the DDF 
Device name Device name as defined in the DDF 
Product revision Product revision as defined in the DDF or E²PROM 
Physics EtherCAT Port configuration: available ports and their types. 
Station Address Station Address denominates a logical address.  

The station address of a slave is set in the master DTM. 

Table 10: General Page Parameters 

 

Physics in the context of EtherCAT Port configuration is described by two 
characters indicating the physical interface of the connection. The coding is 
as follows: 
 

Physics Port type 

K E-Bus 
Y 100Base-TX 
F 100Base-FX  

Table 11: Coding of Parameter "Physics" 
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3.3 Behavior 
At the page Behavior, the parameters of  

• the state machine timeout values 

• the device checkup,  

• the process data  

• and the watchdog timer. 

• are set and displayed. 

 

 
Figure 7: Configuration > Behavior 
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3.3.1 State Machine Timeout 
For various transitions between states of the EtherCAT slave state machine 
the associated timeout values can be configured separately in the state 
machine timeout section of the ‘Behavior’ dialog: 

• I2P 

This value applies to the transition from Init state to Pre-Operational 
state 

• P2S, S2O  

This value applies to the transition from Pre-Operational state to 
Safe-Operational state and from Safe-Operational state to 
Operational state. 

• Back to P, I  

This value applies to the transition from any higher state back to Pre-
Operational state or Init state. 

• O2S  

This value applies to the transition from Operational state to Safe-
Operational state. 

 

 
Note: These timeout values are specified in units of milliseconds. 

 

 
Figure 8: Configuration > Behavior > State Machine Timeout - Configuration 
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3.3.2 Device Check-up 
The device check-up part of the Behavior dialog looks like: 

 
Figure 9: Configuration > Behavior > Device Check 

The following table shows which items identifying the EtherCAT device can 
optionally be verified during device check-up if marked in the dialog 
accordingly. 
 

Parameter Meaning 

VendorID Device’s vendor ID (DDF or stored device-internally) 
Product code Device’s product code (DDF or stored device-internally) 
Revision Device’s revision (DDF or stored device-internally) 
Serial number Device’s Serial number (DDF or stored device-internally) 

Table 12: Parameters Behavior > Device checkup 

 

The values within the DDF file are verified against the corresponding 
information stored in the device (for example, within an E²PROM circuit), if 
the according check box is marked.  
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3.3.3 Process Data 
EtherCAT supplies different command sets for reading and writing: 

• a combined read/write command (LRW) 

• separate read and write commands (LRD/LWR) 

This option allows to choose between these alternatives: 

 
Figure 10: Configuration > Behavior > Process data 

 

Parameter Meaning 

Use LRD/LWR 
instead of LRW 

Logical read and write operation: 
If marked, separate EtherCAT read (LRD) and write 
(LWR) commands will be used. 
Otherwise, a combined EtherCAT read and write (LRW) 
command will be used. 

Table 13: Parameters Behavior > Process data 

 

For more information on EtherCAT read and write commands see the 
EtherCAT Communication Specification, version 1.0, section 6.2 “EtherCAT 
Services”, page 43. 
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3.3.4 Watchdog 
Both the entire PDI (Process Data Interface) and all sync managers 
(separately) are monitored by watchdog timers.  

The following rules apply for resetting the watchdog timers: 

• Each access from the application controller to the EtherCAT Slave 
controller resets the watchdog timer of the Process Data Interface. 

• Each write access to the associated memory area of a sync manager 
resets the sync manager’s watchdog timer. 

The watchdog timeout values can be calculated using the formula given 
below from an individually configurable value and a common multiplier.  

The “Watchdog” part of the “Behavior” dialog allows specifying the 
multiplier and the individual values for PDI watchdog and sync manager 
watchdogs. 

 
Figure 11: Configuration > Behavior > Watchdog 

 

Parameter Meaning 

Set multiplier Watchdog multiplier, content of the register 0x400 
Set PDI watchdog PDI watchdog, see note below 
Set SM watchdog SM watchdog, see note below 

Include WC state 
Bit(s) 

If this check box is marked, an input variable is added to the slave 
device, that shows the working counter state of the EtherCAT slave 
device. 

Table 14: Parameters Behavior > Watchdog 

 

 
Note: The PDI & SM watchdog timeout values are calculated as follows. 

PDI watchdog timeout =  

([value of register 0x400] + 2) * 40 * [value of register 0x 410] 

SM watchdog timeout =  

([value of register 0x 400] + 2) * 40 * [value of register 0x 420] 
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3.4 Process Data 
In EtherCAT, the process data objects (PDO) are assigned to sync 
managers. A sync manager is used for synchronization of data 
communication on a certain communication channel. This channel is 
configured either for input or for output and either for cyclic or for acyclic 
communication. (This is defined within the device description file.) Up to 16 
sync manager can be configured. These are numbered from 0 up to 15. 
The process data dialog only displays the sync manager which is for cyclic 
communication. Possible sync managers for acyclic communication is 
displayed in the CoE MailBox dialog. 
 

The illustration below shows the process data dialog of the EtherCAT 
Generic Slave DTM: 

 
Figure 12: Configuration > Process data 

The process data dialog consists of three parts: 

• Sync Manager area 

• PDO Assignment area 

• PDO Content area 
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3.4.1 Sync Manager 
Within the process data dialog only those PDOs can be shown 
simultaneously, which are assigned to the same sync manager. 

The left part of the process data dialog represents the Sync Manager area 
which is used for choosing the sync manager to be used. It provides the 
Sync Manager table for choosing the sync manager whose PDOs are to 
be displayed, and additionally two checkboxes for PDO assignment and 
PDO configuration which however are relevant in case of variable 
configuration only. 

 
Figure 13: Configuration > Process data > Sync Manager 

The table Sync Manager displays the configuration of the sync managers 
for the device, as defined in its device description file (DDF). For each of 
the 4 sync managers available at maximum in the table, the following 
information is displayed: 
 

Parameter Meaning 

SM Sync Manager channel number (0-15) 

Byte length Sync Manager length in bytes 

Type Sync Manager type (Inputs/ Outputs) 
Flags Sync Manager flags (Flag F = fixed contents) 

Table 15: Parameters Process data > Sync Manager 

 

In case this device supports acyclic communication based on mailboxes the 
Sync Manager 0 is used for the mailbox output (master to slave) and the 
Sync Manager 1 is used for the mailbox input (slave to master).  
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If the device does not support acyclic communication based on mailboxes, 
Sync Manager 0 - 15 can be used for the Process data outputs and inputs 
(also see Figure Configuration > Process data > Sync Manager). 

The size of the Sync Managers is defined by the assigned PDO objects. In 
this case the PDO object is assigned to the Sync Manager 3 and because 
the content of this object has the size 8 the Sync Manager is configured to 
8 bytes. 

 

The read-only checkboxes below show the download flags which are 
defined in device description file. They have the following meaning: 
 

Checkbox Meaning 

PDO Assignment This flag indicates whether to download PDO assignment of 
Sync Manager. 
 If this flag is checked, this means that PDO assignment of 

the slave is writable and special CoE Init-Commands 
should be generated by the EtherCAT Master DTM in the 
Configuration Information File. 

 These CoE Init-commands include the indices of 
transmit/receive PDOs. Therefore the slave knows how 
such PDOs are related to the Sync Manager. 

PDO Configuration This flag indicates whether to download PDO mapping. 
 If this flag is set as checked, this means that PDO 

mapping of the slave is writable and special CoE Init-
Commands should be generated by the EtherCAT Master 
DTM in the Configuration Information File. 

 These CoE Init-Commands include the indices of mapped 
process data objects. Therefore slave knows how mapped 
PDOs are related to transmit /receive PDOs. 

Table 16: Meaning of Checkboxes 
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3.4.2 PDO Assignment (Index 0x1C10- 0x1C1F) 
The upper right part of the process data dialog represents the PDO 
Assignment area for the sync manager chosen within the left part of the 
window. It contains the transmit/receive PDOs. 

Thus the contents of this table depends on the choice of the sync manager 
in the left part of the window. If a sync manager with type “Outputs” is 
selected, all defined receive PDOs (Index 0x1600 -0x17FF) in the device 
description file will be shown in this table.  

Similarly, if a sync manager with type “Inputs” is selected, all defined 
transmit PDOs (Index 0x1A00 -0x1BFF) will be shown in this table. 
 

 
Figure 14: Configuration > Process data > PDO Assignment 

 

For the transmit/receive PDOs assigned to the chosen sync manager, the 
following values are displayed: 
 

Parameter Meaning 

Activate Activation check box for assigned PDO of the selected 
Sync Manager 

Index Object index of the PDO  

Byte length Length of the PDO in bytes 

Name Name of the PDO 
Flags Flags assigned to the PDO 
Description  Description of the PDO 

Table 17: Parameters Process data > PDO Assignment 
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The PDO assignment is stored in a sync manager channel object within the 
object dictionary of the EtherCAT slave. The index of such an object is 
displayed in the headline of the PDO assignment area, and it has a 
relationship with the sync manager channel number(n) :  
Index = 0x1C10 + n  ( n = 0…15) 

In the current example the information was taken from the object with the 
index 0x1C12 indicating sync manager 2 had been chosen for display. 

For slave devices with selectable PDO assignment, PDO/PDOs can be 
selected from the given list of multiple fixed PDOs according to the rules 
defined by the device description file. 
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3.4.3 PDO Content (Index 0x1600-0x17FF, 0x1A00-0x1BFF) 
The lower right part of the process data dialog represents the PDO Content 
area. It contains the mapped process data objects of the transmit/receive 
PDO, which has been selected in the upper right part of the window. 

 
Figure 15: Configuration > Process Data > PDO Content  

For the mapped process data objects, the following values are displayed: 
 

Parameter Meaning 

Index Object index Subindex of the PDO 
Sub index Sub index for the PDO 
Byte length Size of the PDO entry 
Offset Offset of the PDO entry 
Name Name of the PDO entry 
Type Data type of the PDO entry 

Table 18: Parameters Process Data > PDO Content 

 

The PDO content is stored in a transmit/receive object within the object 
dictionary of the EtherCAT slave. You can find the correct index of the 
selected transmit/receive PDO in the headline of the PDO assignment area. 

In the current example the information was taken from the object with index 
0x1604.  

For an explanation of the navigation buttons see section “Table Line 
Buttons” of this document. 
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3.5 Mailbox 

3.5.1 CoE 
For slave devices supporting the CoE MailBox, the following dialog page is 
additionally displayed: 

 
Figure 16: Configuration > Mailbox > CoE Mailbox Settings 

The dialog page provides the following information: 

• The channel number of the sync manager (for mailbox input and output) 

• The configured mailbox size (this applies both for the input mailbox and 
for the output)mailbox  

The complete MailBox configuration for each slave with MailBox support is 
done in the EtherCAT Master-DTM. 
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4 Description 
4.1 Overview Description 

The Description pages contain the following information: 

• XML Viewer page: the devices XML file content in HTML style. 

Description Dialog Pages 
The table below informs about the contents of the Description dialog page: 
 

Subsection Manual 
Page 

XML DDF Viewer 31 

Table 19: Descriptions of the Description Pages 

 

 
Figure 17: Navigation Area – Description 
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4.2 XML DDF Viewer 
The XML DDF Viewer displays the content of the XML DDF file of the 
device. 

Under Filename the absolute file directory path and the file name of the 
displayed DDF file is displayed. Find what offers a search feature to search 
for text contents within the text of the DDF file. 

In the DDF Viewer window on the left side, the line number is displayed for 
simple overview, the further entries show the DDF file in text format. 
 

Parameter Meaning 

FIlename File directory path and the file name of the displayed DDF file. 

Find what Search feature to search for text contents within the text of the 
DDF file. 

Match case Search option 

Match whole word Search option 

Table 20: Device Description – XML DDF Viewerr 

 

The XML DDF Viewer page consists of the following elements: 

• File name shows the absolute path of the DDF file. 

• Find what offers searching for specific text within the DDF file. 

• Using the Find Next button allows you to jump to the next occurrence of 
the text to be searched for within the XML DDF file. 

• Check Match case if you want to perform a case-sensitive search. 

• Check Match whole word if only entire words should match and 
fragments of words should be excluded from matching. 

 

 
Note: You can also access the search functionality of the XML DDF 
Viewer by typing Ctrl-F on the keyboard. 
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6 Glossary 
CoE 

CANopen over EtherCAT 

CoE denominates a method for accessing an object dictionary which has 
been adopted for use in EtherCAT from CANopen. 

DDF 

Device Description File. 

DTM 

Device Type Manager. 

The Device Type Manager (DTM) is a software module with graphical user 
interface for the configuration or for diagnosis of devices. 

E²PROM 

Electronically erasable Programmable Read-Only Memory 

E-Bus 

Bus system based on LVDS standard 

EDS 

Electronic Data Sheet 

EtherCAT-Master 

A device which is responsible for the configuration, parameterization of the 
EtherCAT segment, all connected devices’ controllers, and cyclic process 
data exchange, mailbox and diagnostics services. 

EtherCAT-Port 

Physical type of data transmission used by EtherCAT. An EtherCAT Slave 
Master can have up to 4 EtherCAT ports. Can be one of the following three 
alternatives: 

• E-Bus 

• 100Base-TX 

• 100Base-FX 

EtherCAT-Slave 

A device which is configured by the Master, receives telegrams with output 
data, commands from it and provides input and status data. 

FDT 

Field Device Tool 

FDT specifies an interface, in order to be able to use DTM (Device Type 
Manager) in different applications of different manufacturers 
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FMMU 

Fieldbus Memory Management Unit  

A field bus memory management unit organizes a mapping of EtherCAT 
logical addresses to physical addresses. 

LVDS 

Low Voltage Differential Signals 

A data transmission standard specified in ANSI/TIA/EIA-644-1995 and 
used in Beckhoff’s E-Bus. 

 

Object Dictionary 

An object dictionary is a storage area for device parameter data structures. 
It is accessed in standardized manner very similarly as this is done in 
CANopen.. 

PDO 

Process Data Objekt 

Specific data object for cyclic data communication. 

SDO 

Service Data Objekt 

Specific data object for acyclic data communication, i.e. mailbox-based 
communication. It is typically used for accessing the object dictionary. 

Sync Manager 

Synchronization Manager 

A sync manager synchronizes the data communication on a specific 
communication channel. It is configured for managing either input or output 
and for working either cyclically or acyclically based on mailboxes. 
Configuration is done within the DDF file. Up to 4 sync managers numbered 
0 to 3 can be configured. 

XML 

Extensible Markup Language 

A versatile data storage format defined by the World Wide Web Consortium 
(W3C). It is based on elements and attributes. In EtherCAT, it is used in 
device descriptions stored in DDF files. 
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7 Appendix 
7.1 User Rights 

User-rights are set within the FDT-container. Depending on the level the 
configuration is accessible by the user or read-only. 

To access the Configuration panes of the Generic EtherCAT Slave DTM 
you do not need special user rights. Also all users can select the decimal or 
hexadecimal Display mode or sort table entries. 
 

 
Note: To edit, set or configure the parameters of the Configuration 
panes, you need user rights for Maintenance, for Planning Engineer or for 
Administrator. 

 

The following tables give an overview of the user right groups and which 
user rights you need to configure the single parameters. 
 

7.1.1 Configuration 
 Observer Operator Maintenance Planning 

Engineer 
Adminis-
trator 

     General D D X X X 
     Behavior D D X X X 
     Process Data D D X X X 
     Mailbox D D X X X 

Table 21:  Configuration (D = Displaying, X = Editing, Configuring) 
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